MSP430™ ultra-low-power (ULP) FRAM technology now joins the LaunchPad™ family.

The MSP-EXP430FR5969 LaunchPad (or the "FR5969 LaunchPad") is an easy-to-use evaluation module (EVM) for the MSP430FR5969 microcontroller. It contains everything needed to start developing on MSP430's ULP FRAM platform, including on-board emulation for programming, debugging, and energy measurements.

Figure 1. MSP-EXP430FR5969
Contents

1 Getting Started .................................................................................................................. 3
2 Hardware .......................................................................................................................... 5
3 Software Examples ........................................................................................................... 18
4 Additional Resources ....................................................................................................... 26
5 FAQs ................................................................................................................................. 28
6 Schematics ........................................................................................................................ 29

List of Figures

1 MSP-EXP430FR5969 ........................................................................................................... 1
2 EVM Overview .................................................................................................................. 5
3 Block Diagram .................................................................................................................. 6
4 MSP430FR5969 Pinout ....................................................................................................... 7
5 eZ-FET Emulator .............................................................................................................. 8
6 eZ-FET Isolation Jumper Block Diagram .......................................................................... 9
7 Application Backchannel UART in Device Manager ....................................................... 10
8 MSP430FR5969 LaunchPad Power Domain Block Diagram ........................................... 11
9 Debugger Power Configuration – USB eZ-FET and JTAG ............................................... 12
10 External Power Configuration – External and BoosterPack .......................................... 13
11 Super Cap Power Configuration – Charging and Running Standalone .......................... 15
12 FR5969 LaunchPad to BoosterPack Connector Pinout .................................................. 17
13 Directing the Project—Import Function to the Demo Project ........................................ 19
14 When CCS Has Found the Project ................................................................................ 20
15 FRAM Unified Memory with Dynamic Partitioning ...................................................... 26
16 MSP-EXP430FR5969 Software Examples in TI Resource Explorer ............................... 27
17 Schematic 1 of 5 ............................................................................................................. 29
18 Schematic 2 of 5 ............................................................................................................. 30
19 Schematic 3 of 5 ............................................................................................................. 31
20 Schematic 4 of 5 ............................................................................................................. 32
21 Schematic 5 of 5 ............................................................................................................. 33

List of Tables

1 Isolation Block Connections ............................................................................................. 9
2 Hardware Change Log ..................................................................................................... 18
3 Software Examples ......................................................................................................... 18
4 IDE Minimum Requirements for MSP430FR5969 .......................................................... 19
5 Source Files and Folders ............................................................................................... 21
6 FRAM Endurance Calculation for 1KB Block of FRAM ................................................. 23
7 How MSP430 Device Documentation is Organized ...................................................... 26
1 Getting Started

1.1 Introduction

The MSP-EXP430FR5969 LaunchPad (or the "FR5969 LaunchPad") is an easy-to-use evaluation module (EVM) for the MSP430FR5969 microcontroller. It contains everything needed to start developing on MSP430’s ULP FRAM platform, including on-board emulation for programming, debugging, and energy measurements. The board features on-board buttons and LEDs for quick integration of a simple user interface as well as a super capacitor (super cap) that allows standalone applications without external power supply. The MSP430FR5969 device features embedded FRAM (Ferroelectric Random Access Memory), a nonvolatile memory known for its ultra-low power, high endurance, and high-speed write access.

Rapid prototyping is a snap thanks to 20-pin headers and a wide range of BoosterPack plug-in modules that enable technologies such as wireless connectivity, graphical displays, environmental sensing, and much more. More information about the LaunchPad, supported BoosterPacks, and available resources can be found at TI’s LaunchPad portal and the LaunchPad wiki for design resources and example projects.

The out-of-box experience provided with the MSP-EXP430FR5969 LaunchPad uses the 430BOOST-SHARP96 Dot Matrix Memory LCD BoosterPack. The display enables a better user experience and allows developers to more easily model their end application.

The MSP-EXP430FR5969 LaunchPad and 430BOOST-SHARP96 BoosterPack are available in a bundled package from the TI eStore, with part number MSP-BNDL-FR5969LCD. The MSP-EXP430FR5969 LaunchPad is not available standalone at this time.

Free software development tools are also available, such as TI’s Eclipse-based Code Composer Studio™ IDE and IAR Embedded Workbench™ IDE. More information about the LaunchPad, the supported BoosterPacks, and available resources can be found at TI’s LaunchPad portal and the MSP430 LaunchPad wiki for design resources and example projects.

1.2 Key Features

- MSP430 ultra-low-power FRAM technology based MSP430FR5969 16-bit MCU
- 20-pin LaunchPad standard that leverages the BoosterPack ecosystem
- 0.1-F super capacitor for standalone power
- Onboard eZ-FET emulation
- Two buttons and two LEDs for user interaction
- Backchannel UART through USB to PC

1.3 Kit Contents

- 1x MSP-EXP430FR5969
- 1x Micro USB cable
- 1x Quick Start Guide

1.4 First Steps – Out-of-Box Experience

An easy way to get familiar with the EVM is by using its pre-programmed out-of-box code. It demonstrates some key features from a user level.

The out-of-box experience is based on the 430BOOST-SHARP96 Dot Matrix Memory LCD BoosterPack to better showcase the device functionality.

The first step is to connect the BoosterPack to the LaunchPad and ensure the correct placement: Rockets facing upward.

Now the included Micro USB cable is used to connect the LaunchPad to the computer.
The board is pre-programmed with the out-of-box demo. A splash screen displaying the TI logo indicates that the software is loaded and the board has powered up as expected. An LED also blinks briefly at startup.

**NOTE:** The BoosterPack needs to be plugged in at device power up for the out-of-box code to work properly.

The user interacts with the demo by using the two capacitive touch sliders on the BoosterPack and by using push buttons S1 (left button) and S2 (right button). The LCD provides a method to interact with the various user modes and view the output based on user interaction.

A more detailed explanation of each mode can be found in Section 3.

### 1.5 Next Steps – Looking Into the Provided Code

After the EVM features have been explored, the fun can begin. It is time to open an integrated development environment (IDE) and start digging into the code example. Refer to Section 3 for more information on IDEs and where to download them.

The out-of-box source code and more code examples are provided for download at [http://www.ti.com/tool/msp-exp430fr5969](http://www.ti.com/tool/msp-exp430fr5969). Code is licensed under BSD and TI encourages reuse and modifications to fit specific needs.

Section 3 describes all functions in detail and provides a project structure to help familiarize yourself with the code.

With the onboard eZ-FET emulator, debugging and downloading new code is a breeze. A USB connection between the EVM and a PC through the provided USB cable is all that is needed.
2 Hardware

Figure 2 shows an overview of the LaunchPad hardware.

Figure 2. EVM Overview
2.1 Block Diagram

Figure 3 shows the block diagram.

![Block Diagram](image)

2.2 Hardware Features

2.2.1 MSP430FR5969

The MSP430FR5969 is the first device in TI’s new ULP FRAM technology platform. FRAM is a cutting edge memory technology, combining the best features of flash and RAM into one nonvolatile memory. More information on FRAM can be found at [www.ti.com/firam](http://www.ti.com/firam).

Device features include:
- 1.8-V to 3.6-V operation
- Up to 16-MHz system clock and 8-MHz FRAM access
- 64KB FRAM and 2KB SRAM
- Ultra-low-power operation
- Five timer blocks and up to three serial interfaces (SPI, UART, or I²C)
- Analog: 16-channel 12-bit differential ADC and 16-channel comparator
- Digital: AES256, CRC, DMA, and hardware MPY32
To compare the various MSP430 derivatives, download the MSP430 Product Brochure (SLAB034), which is also available from http://www.ti.com/msp430. The brochure has a table that lets you see, at a glance, how the families compare, and their pricing. This document is frequently updated, as new MSP430 derivatives become available.
2.2.2 eZ-FET Onboard Emulator

To keep development easy and cost effective, TI's LaunchPad development tools integrate an onboard emulator, eliminating the need for expensive programmers.

The FR5969 LaunchPad has the new eZ-FET emulator (see Figure 5), a simple and low-cost debugger that supports almost all MSP430 device derivatives.

![Figure 5. eZ-FET Emulator](image)

The eZ-FET provides a "backchannel" UART-over-USB connection with the host, which can be very useful during debugging and for easy communication with a PC. The provided UART supports hardware flow control (RTS and CTS), although these signals are not connected to the target by default.

The dotted line through J13 shown in Figure 5 divides the eZ-FET emulator from the target area. The signals that cross this line can be disconnected by jumpers on J13, the isolation jumper block. More details on the isolation jumper block are in Section 2.2.3.

The eZ-FET hardware can be found in the schematics in Section 6 and in the accompanying design files (SLAC645). The software and more information about the debugger can be found at the eZ-FET lite wiki.

2.2.3 Emulator Connection – Isolation Jumper Block

The isolation jumper block at Jumper J13 allows the user to connect/disconnect signals that cross from the eZ-FET domain into the FR5969 target domain. This includes eZ-FET Spy-Bi-Wire signals, application UART signals, and 3V3 and 5V power (see Table 1).

Reasons to open these connections:
- To remove any and all influence from the eZ-FET emulator for high accuracy target power measurements
- To control 3-V and 5-V power flow between eZ-FET and target domains
- To expose the target MCU pins for other use than onboard debugging and application UART communication
- To expose programming and UART interface of the eZ-FET so it can be used for devices other than the onboard MCU.
Table 1. Isolation Block Connections

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>V+</td>
<td>3.3-V rail, derived from VBUS by an LDO in the eZ-FET domain</td>
</tr>
<tr>
<td>RTS &gt;&gt;</td>
<td>Backchannel UART: Ready-To-Send, for hardware flow control. The target can use this to indicate whether it is ready to receive data from the host PC. The arrows indicate the direction of the signal.</td>
</tr>
<tr>
<td>CTS &lt;&lt;</td>
<td>Backchannel UART: Clear-To-Send, for hardware flow control. The host PC (through the emulator) uses this to indicate whether or not it is ready to receive data. The arrows indicate the direction of the signal.</td>
</tr>
<tr>
<td>RXD &lt;&lt;</td>
<td>Backchannel UART: the target FR5969 receives data through this signal. The arrows indicate the direction of the signal.</td>
</tr>
<tr>
<td>TXD &gt;&gt;</td>
<td>Backchannel UART: the target FR5969 sends data through this signal. The arrows indicate the direction of the signal.</td>
</tr>
<tr>
<td>RST</td>
<td>Spy-Bi-Wire emulation: SBWTDO data signal. This pin also functions as the RST signal (active low)</td>
</tr>
<tr>
<td>TST</td>
<td>Spy-Bi-Wire emulation: SBWTCK clock signal. This pin also functions as the TST signal</td>
</tr>
</tbody>
</table>

2.2.4 14-Pin JTAG Connector

This EVM contains a footprint for TI’s standard 14-pin MSP430 JTAG header. This connector can be used as needed. For debug purposes, this connector offers 4 wire JTAG compared to the 2-wire Spy-Bi-Wire from the eZ-FET. In certain use cases this can be advantageous. The MSP-FET430UIF or another MSP430 external debug tool can be used. This JTAG connector can be used to power the system directly or can be used with external power. See Section 2.3 for more details on the JTAG system power requirements.
2.2.5 Application (or "Backchannel") UART

The backchannel UART allows communication with the USB host that isn't part of the target application's main functionality. This is very useful during development, and also provides a communication channel to the PC host side. This can be used to create GUIs and other programs on the PC that communicate with the FR5969 LaunchPad.

The pathway of the backchannel UART is shown in Figure 6. The backchannel UART (USCI_A0) is independent of the UART on the 20-pin BoosterPack connector (USCI_A1).

On the host side, a virtual COM port for the application backchannel UART is generated when the LaunchPad enumerates on the host. You can use any PC application that interfaces with COM ports, including terminal applications like Hyperterminal or Docklight, to open this port and communicate with the target application. You need to identify the COM port for the backchannel. On Windows PCs, Device Manager can assist (see Figure 7).

The backchannel UART is the "MSP Application UART1" port. In this case, Figure 7 shows COM13, but this varies from one host PC to the next. After you identify the correct COM port, configure it in your host application, according to its documentation. You can then open the port and begin talking to it from the host.

On the target FR5969 side, the backchannel is connected to the USCI_A0 module.

The eZ-FET has a configurable baudrate, therefore, it is important that the PC application configures the baudrate to be the same as what's configured on the USCI_A0.

The eZ-FET also supports hardware flow control, if desired. Hardware flow control (CTS/RTS handshaking) allows the target FR5969 and the emulator to tell each other to wait before sending more data. At low baud rates and with simple target applications, flow control may not be necessary. Applications with faster baud rates and more interrupts to service have a higher likelihood that they cannot read the USCI_A0's RXBUF register in time, before the next byte arrives. If this happens, the USCI_A0's UCA0STATW register will report an overrun error.

2.2.6 100-mF Super Capacitor (Super Cap)

A 100-mF (0.1-F) super cap is mounted onboard and allows powering the system without any external power. This highlights the ultra-low power of the MSP430FR5969 target device. See how long you can run your application on the super cap alone!

For more power information on the super cap, see Section 2.3.5.
2.3 Power

The board is designed to support five different power scenarios. The board can be powered by the eZ-FET or JTAG debugger, external power, BoosterPack power, or standalone super cap power.

Figure 8. MSP430FR5969 LaunchPad Power Domain Block Diagram
2.3.1  eZ-FET USB Power

The most common scenario is power from USB through the eZ-FET debugger. This provides 5-V power from USB and also regulates this power rail to 3.3 V for eZ-FET operation and 3.3 V to the target side of the LaunchPad. Power from the eZ-FET is controlled by jumper J13. For 3.3 V, ensure that a jumper is connected across the J13 "V+" terminal. The eZ-FET is a debugger, so J10 must be set to debugger for power to reach the target MSP430FR5969 device.

For the power configuration diagram, see Figure 9.

2.3.2  14-Pin JTAG

When powering directly from the JTAG connector through the MSP-FET430UIF or other MSP430 debugger tool, ensure that jumper J10 is set to "Debugger." JTAG debugging can also be used with an external power source, when J10 is set to "External," and some external power source is connected through J12. In this case the JTAG debugger will sense the external power and debug the system without providing its own power.

For power configuration diagram, see Figure 9.

Figure 9. Debugger Power Configuration – USB eZ-FET and JTAG
2.3.3 External Power Supply

An extra header J12 is present on the board to supply external power. When supplying external power, jumper J10 must be set to “External.” It is important to understand the device voltage operation specifications when supplying external power. The MSP430FR5969 has an operating range of 1.8V – 3.6V. More information can be found in the device data sheet.

For power configuration diagram, see Figure 10.

2.3.4 BoosterPack

In some use cases it might be required to power the board from a BoosterPack. When powered from a BoosterPack, the BoosterPack voltage should be across J4 Pin1 (Vcc) and J5 Pin20 (GND). This complies with the BoosterPack pinout shown in Section 2.7. These pins are connected directly to the FR5969 target device, and do not require any specific jumper configuration. Header J1 also provides power directly to the target device.

Because J1 and the BoosterPack headers are connected directly to the target device $V_{cc}$, there are two primary consequences:

- The super cap cannot charge through J11. Use of the super cap with this power scenario is not recommended.
- Current of the target device through J9 cannot be measured. It is best to remove J9 in this scenario to prevent back-powering of any additional circuitry such as the eZ-FET.

For power configuration diagram, see Figure 10.

---

**Figure 10. External Power Configuration – External and BoosterPack**
2.3.5 Super Cap

2.3.5.1 Charging the Super Cap

To charge the super cap, jumper J11 is used. By default there is no jumper across J11. Place a jumper across J11 to charge the super cap. If another jumper is not handy, the GND jumper on the isolation jumper block can be used- as this jumper doesn't actually disconnect the GND connection.

To charge the super cap, power must be coming from a debugger (eZ-FET or JTAG) or external power through J10. External power through J1 or a BoosterPack will not charge the super cap through J11.

Placing a jumper across J11 will charge the super cap when there is 3.3V $V_{cc}$ present, regardless of the state of the Bypass/Use J2 jumper, however if J2 is in the "Bypass" state, changing it over to the "Use" state will remove power from the target MSP430FR5969 and it will be reset.

2.3.5.2 Using the Super Cap

To use the super cap to power the LaunchPad, first change the J2 jumper to select "Use" and then set a jumper on J11 to charge the super cap. After waiting for it to charge, any external power can be removed from the system, and it will be powered completely by the super cap.

To remove any additional power drain from the super cap, remove any jumper to disconnect power to any external source. This can be J11, J10, or J13 depending on the power configuration. This prevents the super cap from back-powering the debug circuitry or any external power circuitry connected.

The most effective method for charging the capacitor is outlined in the following steps. These steps assume the LaunchPad is powered by USB cable through the eZ-FET debugger.

1. Set "Power Selector" jumper (J10) to "Debugger" position
2. Set jumper J2 to "Use" super cap position
3. Set jumper J11 to "Charge" super cap position
4. Set "V+" jumper J13
5. Connect board to PC with USB cable
6. Allow 2-3 minutes for the super cap to charge (time may vary depending on initial charge of the super cap) to full $V_{cc}$
7. Remove the "V+" jumper J13

For power configuration diagram, see Figure 11.
2.3.5.3 **Disabling the Super Cap**

To disable the super cap, change J2 to "Bypass," and remove jumper J11 to prevent additional current for charging the super cap. With these 2 jumper selections, the super cap is completely disconnected from the system.
2.4 **Measure MSP430 Current Draw**

A specific jumper J9 is placed on the LaunchPad to allow for measuring current draw of the MSP430FR5969 device. The current measured includes the FR5969, and any current drawn through the BoosterPack headers and jumper J1.

To measure ultra-low power, follow these steps:

1. Remove the J9 jumper; attach an ammeter across this jumper.
2. Consider the effect that the backchannel UART and any circuitry attached to the FR5969 may have on current draw. Maybe these should be disconnected at the isolation jumper block, or their current sinking and sourcing capability at least considered in the final measurement.
3. Make sure there are no floating input I/Os. These cause unnecessary extra current draw. Every I/O should either be driven out or, if an input, should be pulled or driven to a high or low level.
5. Measure the current. (Keep in mind that if the current levels are fluctuating, it may be difficult to get a stable measurement. It is easier to measure quiescent states.)

2.5 **Clocking**

The FR5969 LaunchPad provides external clocks in addition to the internal clocks in the device.

- Y4: a 32-kHz crystal
- Y1: an unpopulated region that supports HF crystal or resonator (4 to 24 MHz)

The 32-kHz crystal allows for lower LPM3 sleep currents than do the other low-frequency clock sources. Therefore, the presence of the crystal allows the full range of low-power modes to be used.

For more information about internal clocks and how to use the 32-kHz or HF crystal, see the MSP430FR59xx family user's guide.

2.6 **Using the eZ-FET Emulator With a Different Target**

The eZ-FET emulator on the FR5969 LaunchPad can interface to most MSP430 derivative devices, not just the on-board FR5969 target device.

To do this, disconnect every jumper in the isolation jumper block. This is necessary because the emulator cannot connect to more than one target at a time over the Spy-Bi-Wire (SBW) connection.

Next, make sure the target board has proper connections for Spy-Bi-Wire. Note that to be compatible with SBW, the capacitor on RST/SBWTDIO cannot be greater than 2.2 nF. The documentation for designing MSP430 JTAG interface circuitry is the *MSP430 Hardware Tools User's Guide* (SLAU278).

Finally, wire together these signals from the emulator's side of the isolation jumper block to the target hardware:

- 3.3 V (V+)
- GND
- SBWTDIO
- SBWTCK
- TXD (if the UART backchannel is to be used)
- RXD (if the UART backchannel is to be used)
- CTS (if hardware flow control is to be used)
- RTS (if hardware flow control is to be used)

This wiring can be done either with jumper wires or by designing the board with a connector that plugs into the isolation jumper block.
2.7 BoosterPack Pinout

The FR5969 LaunchPad adheres to the 20-pin LaunchPad pinout standard. A standard was created to aid compatibility between LaunchPad and BoosterPack tools across the TI ecosystem.

The 20-pin standard is compatible with the 40-pin standard used by other LaunchPads like the MSP-EXP430F5529LP. This allows some subset of functionality of 40-pin BoosterPacks to be used with 20-pin LaunchPads.

This having been said, while most BoosterPacks are compliant with the standard, some are not. The FR5969 LaunchPad is compatible with all 20-pin BoosterPacks that are compliant with the standard. If the reseller or owner of the BoosterPack does not explicitly indicate compatibility with the FR5969 LaunchPad, you might want to compare the schematic of the candidate BoosterPack with the LaunchPad to ensure compatibility. Keep in mind that sometimes conflicts can be resolved by changing the FR5969 device pin function configuration in software. More information about compatibility might also be found at http://www.ti.com/launchpad.

Figure 12 shows the 20-pin pinout of the FR5969 LaunchPad.

Note that software's configuration of the pin functions plays a role in compatibility. The FR5969 LaunchPad side of the dashed line shows all of the functions for which the FR5969 device's pins can be configured. This can also be seen in the MSP430FR5969 data sheet. The BoosterPack side of the dashed line shows the standard. The FR5969 function whose color matches the BoosterPack function shows the specific software-configurable function by which the FR5969 LaunchPad adheres to the standard.

Below are the pins exposed at the BoosterPack connector.

Also shown are functions that map with the BoosterPack standard.

* Note that to comply with the I2C channels of the BoosterPack standard, a software-emulated I2C must be used.

(!) Denotes I/O pins that are interrupt-capable.

Light Gray boxes in the BoosterPack standard indicate that some LaunchPads may be missing that functionality.
2.8 Design Files

Schematics can be found in Section 6. All design files including schematics, layout, bill of materials (BOM), and Gerber files are made available in a zip folder (SLAC645) from ti.com. The zip folder also contains the software examples, TI-TXT object-code firmware images, and documentation.

The MSP-EXP430FR5969 LaunchPad was designed in Mentor Graphics PADS schematic and layout. A free viewer is available to see both the schematic and layout files on the Mentor Graphics website at http://www.mentor.com/pcb/downloads/pads-pcb-viewer. A full time-limited version of PADS is available online for free. This version has complete functionality until the 30 day license expires. This version can be downloaded directly from http://www.mentor.com/pcb/product-eval/pads-download-evaluation.

2.9 Hardware Change Log

Table 2 shows the hardware revision history.

<table>
<thead>
<tr>
<th>PCB Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rev 1.6</td>
<td>Initial Release</td>
</tr>
</tbody>
</table>

3 Software Examples

There are two software examples included with the FR5969 LaunchPad, which can be found in the zip source folder (SLAC645), shown in Table 3.

<table>
<thead>
<tr>
<th>Demo Name</th>
<th>BoosterPack Required</th>
<th>Description</th>
<th>More Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>430BOOST-SHARP96_OutOfBox</td>
<td>430BOOST-SHARP96</td>
<td>The out-of-box demo pre-programmed on the LaunchPad from the factory. Its function was described in Section 1.4. Demonstrates features of MSP430FR5969 ULP FRAM device</td>
<td>Section 3.3</td>
</tr>
<tr>
<td>430BOOST-SHARP96_GrlibDisplay</td>
<td>430BOOST-SHARP96</td>
<td>A very simple example showing how to use MSP430 Graphics Library (grlib) to display graphics primitives and images.</td>
<td>Section 3.4</td>
</tr>
</tbody>
</table>

3.1 MSP430 Software: Driver Library, Graphics Library, and Capacitive Touch Library

The examples are built upon three MSP430 libraries available from TI shown below. All three libraries are available as part of MSP430Ware. Downloading CCS will include MSP430Ware along with TI Resource Explorer.

- Driver library (driverlib): a foundational MSP430 software library, useful for interfacing with all MSP430 core functions and peripherals, especially clocks and power.
- Graphics library (grlib): a library for interfacing MSP430 devices to dot-matrix LCD displays. Contains primitives for simple drawing as well as images and more.
- Capacitive Touch Library: a library for capacitive touch sensing applications. This library supports the use of buttons, sliders, wheels and more. Highly configurable for each application.

When you begin your own development, you will need more information about these libraries than can be included in this User’s Guide. All the information you need is in MSP430Ware or specific library documentation linked above.
3.2 Development Environment Requirements

To use any of the below software examples with the MSP430FR5969 LaunchPad, you must have an integrated development environment (IDE) that supports the MSP430FR5969 device.

Table 4. IDE Minimum Requirements for MSP430FR5969

<table>
<thead>
<tr>
<th>Code Composer Studio™ IDE</th>
<th>IAR Embedded Workbench™ IDE</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCS v5.5 or later</td>
<td>IAR EW430 v5.60 or later</td>
</tr>
</tbody>
</table>

For more details on where to download the latest IDE, see Section 4.3.

3.2.1 CCS

CCS v5.5 or higher is required. When CCS has been launched, and a workspace directory chosen, use Project→Import Existing CCS Eclipse Project. Direct it to the desired demo’s project directory containing main.c. This is either the 430BOOST-SHARP96_OutOfBox or 430BOOST-SHARP96_GrlibDisplay project (see Figure 13).

![Figure 13. Directing the Project—Import Function to the Demo Project](image)

Selecting the \CCS or \CCS_Code_Size_Limited sub-directory also works. The CCS-specific files are located there.

When you click "OK", CCS should recognize the project and allow you to import it. The indication that CCS has found it is that the project appears in the box shown in Figure 14, and it has a checkmark to the left of it.
Sometimes CCS finds it, but does not have a checkmark; this might mean that your workspace already has a project by that name. You can resolve this by re-naming or deleting that project. (Even if you don't see it in the CCS workspace, be sure to check the workspace’s directory on the file system.)

Finally, click "Finish". Note that even if you check the "Copy projects into workspace" checkbox, most of the resources are linked and will remain in their original location.

3.2.2 IAR

IAR Embedded Workbench™ IDE v5.60 or higher is required. To open the demo in IAR, simply choose File→Open→Workspace…, and direct it to the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is contained within this file.

The subdirectory also has an *.ewp project file; this file can be opened into an existing workspace, using Project→Add-Existing-Project….

Although the software examples have all the code required to run them, IAR users may wish to download and install MSP430Ware, which contains driverlib, grlib, capacitive touch library, and the TI Resource Explorer. These are already included in a CCS installation (unless the user selected otherwise).

3.3 Out-of-Box Software Example

This section describes the functionality and structure of the out-of-box software that is preloaded on the EVM.

NOTE: The out-of-box experience relies on the 430BOOST-SHARP96 BoosterPack and has a very limited use without it. A 430BOOST-SHARP96 BoosterPack is included in the MSP-BNDL-FR5969LCD bundle along with the FR5969 LaunchPad.
The full out-of-box demo cannot be built with the free version of CCS or IAR (IAR Kickstart) due to the code size limit. To bypass this limitation, a code-size-limited CCS version is provided that has most functionality integrated into a library. The code that is built into the library can be viewed by the user, but it cannot be edited. For full functionality, download the full version of either CCS or IAR.

There are five applications in the out-of-box software. All of them are in one project and the different applications can be cycled through in the user interface.

### 3.3.1 Source File Structure

The project is split into multiple files. This makes it easier to navigate and reuse parts of it for other projects.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main.c</td>
<td>The user experience demo main function, shared ISRs, and other functions</td>
</tr>
<tr>
<td>ActivePowerMeasure.c</td>
<td>Main function file for Active Mode Power app</td>
</tr>
<tr>
<td>ClockApp.c</td>
<td>Main function file for Clock app</td>
</tr>
<tr>
<td>FR59xx_EXP.c</td>
<td>File for handling system init, main menu, and button operations</td>
</tr>
<tr>
<td>FRAMSpeedApp.c</td>
<td>Main function file for FRAM Speed app</td>
</tr>
<tr>
<td>Game.c</td>
<td>Main function file for SliderBall video game app</td>
</tr>
<tr>
<td>SYS.c</td>
<td>Functions to enter and exit LPM3.5</td>
</tr>
<tr>
<td>myTimer.c</td>
<td>Contains all timer-based functions and interrupts</td>
</tr>
<tr>
<td>ULPMeter.c</td>
<td>Main function file for Battery Free Stopwatch app</td>
</tr>
<tr>
<td>Library: CTS</td>
<td>Capacitive Touch Software Library (CAPSENSELIBRARY)</td>
</tr>
<tr>
<td>Library: Driverlib</td>
<td>Device driver library (MSP430DRIVERLIB)</td>
</tr>
<tr>
<td>Library: grlib</td>
<td>Graphics library for the SHARP LCD (MSP430-GRLIB)</td>
</tr>
<tr>
<td>Folder: Preloaded images</td>
<td>Images for the LCD screen</td>
</tr>
</tbody>
</table>

### 3.3.2 Navigation and Main Menu

Upon powering up the out-of-box demo, the title screens appear on the LCD, and are followed by the main selection menu. The main menu displays all the applications available in the demo. The application options in the menu are highlighted by using the left capacitive touch slider.

**NOTE:** Only the left capacitive touch slider is activated for navigation.

Once an application is selected, the right button (S2) is used to enter the application. To change the application or exit, use the left button (S1) and then navigate the main menu to switch to a different application.

### 3.3.3 Clock Application

**NOTE:** This application relies on the operation of the 32.768-kHz clock crystal that is pre-populated on the LaunchPad.

To enter this application the "Clock" option on the main menu must be highlighted and the right button (S2) then pushed.

Immediately upon entering the Clock app, the user is expected to setup the date and time details before the clock starts running. This needs to be done every time the application is entered since the clock values are not maintained when running any of the other applications. To set the time and data parameters use the following steps:

1. On entering the app, the parameter being modified will begin to blink
2. The left capacitive touch slider can be used to increment or decrement the blinking parameter by
3. Placing a finger on the top or bottom portion, respectively, of the slider may lock the blinking parameter by placing a finger in the middle of the left capacitive touch slider.

4. The parameter being modified can be changed with the right button (S2).

5. Repeat steps 2 to 4 until all parameters have been set, after which the clock will reset the seconds and begin to track the time from the set time and date.

When the clock begins to run, note that an option to turn on or off the seconds display is provided using the left button (S1). This is useful when attempting to measure power. The device spends most of the time in standby (LPM3), waking up every one second to update the RTC values. However, if the display is updated every second, the average power is much higher than just the LPM3 power due to time and energy required to modify the LCD through SPI. If the SecON option is turned off, the device continues to provide a one-second wakeup to update the RTC values, but the display is updated only once a minute to save power. In this configuration, the device power will be similar to power in LPM3 (refer device data sheet for exact values).

When attempting to measure power using the Current jumper J9, ensure that the meter is in place before the board is powered up. If this jumper is removed while running the application, the results in a power cycle of the device (since the connection to Vcc is broken) and the clock parameters will need to be re-entered.

### 3.3.4 FRAM Speed Application

To enter the FRAM Speed app, the "FRAM Speed" option on the main menu must be highlighted and the right button (S2) then pushed. In this application, the FRAM write speed (in kilobytes per second), the total data written to FRAM (in kilobytes), and the FRAM endurance (in percentage) is tracked and displayed on the LCD. No user interaction is required.

The application uses Direct Memory Access (DMA) to transfer data to a 1KB block of FRAM. The starting address of this block is defined and can be modified within the FRAMSpeedApp.h file. Note that changing this location can cause an overlap with other application code. This is not advised since code may be overwritten while running the application. Hence special care needs to be taken to evaluate the size of the code to ensure that it is not over-written while measuring the FRAM write speed.

It should be noted that this application is optimized for speed rather than power. The speed of this application is approximately 7500KB (7.5MB) per second. On a flash device, the achievable speed would be approximately 13KB per second.

Larger blocks of data can be written to, resulting in faster write speeds, but also higher power consumption. For more information on how to optimize FRAM write speeds, refer to the application report Maximizing FRAM Write Speed on the MSP430FR57xx (SLAA498).

In this application, the system main clock is configured to use the DCO at 8 MHz. The application configures the DMA transfer of data and continuously executes it while remaining in LPM0. Each time the DMA writes the 1KB block, a count variable is incremented and the next DMA transfer is triggered. A timer is set up to interrupt the FRAM writing every 0.25 second to calculate the speed, total the kilobytes of data written, update the endurance, and then output these parameters on the LCD.

Note that the FRAM endurance percentage is retained after a power cycle. To exit the application and stop the FRAM writes, the left button (S1) can be pushed allowing the user to return to the main menu.

### 3.3.4.1 Understanding the Numbers Behind the FRAM Speed Application

The LCD is updated every 250 ms with an updated percentage change in the FRAM endurance. To calculate the endurance, some approximations were made in order to provide a meaningful output on the LCD.

Every 250 ms, 1.8MB of FRAM are programmed with a pattern. Hence the speed of FRAM writes is calculated as 7.564 MB/s. The FRAM is written to in blocks of 1K bytes; it is this 1KB block that is subject to the lifetime FRAM endurance specification.

FRAM endurance of block = \( E = 10^{15} \) write cycles. This is a minimum specification for FRAM endurance found in the device data sheet.
Table 6. FRAM Endurance Calculation for 1KB Block of FRAM

<table>
<thead>
<tr>
<th>Variable</th>
<th>Derived From</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>E (FRAM Endurance)</td>
<td>Data sheet</td>
<td>10^10 writes</td>
</tr>
<tr>
<td>W (Write Speed)</td>
<td>Application</td>
<td>7.564 MB/second</td>
</tr>
<tr>
<td>B (FRAM block size)</td>
<td>Application</td>
<td>1KB (1024 bytes)</td>
</tr>
<tr>
<td>N (number of writes to a unique byte/sec)</td>
<td>N = W / B</td>
<td>7386 writes/second</td>
</tr>
<tr>
<td>T_LCD (time between LCD updates)</td>
<td>Application</td>
<td>250 ms</td>
</tr>
<tr>
<td>T_LIFE (time until endurance spec is met)</td>
<td>T_LIFE = E / N</td>
<td>1.35 × 10^{11} seconds (over 4000 years)</td>
</tr>
<tr>
<td>L (lifetime percentage reduction/LCD update)</td>
<td>L = (T_LCD / T_LIFE) × 100</td>
<td>1.85 × 10^{-10}%</td>
</tr>
</tbody>
</table>

The calculated value is rounded up to 2 × 10^{-10}%, or 0.00000000002%. This is the amount the FRAM endurance is decremented on the LCD every 250 ms.

Note that the FRAM endurance percentage is retained during on a power cycle. This parameter is preserved by storing it in FRAM and preventing the variable from being overwritten on a power cycle. Refer to the NO INIT and LOCATION pragmas in the CCS compiler documentation for more details. This parameter will be reset when the device is reprogrammed, and the address overwritten.

3.3.5 Battery Free Application

To enter the Battery Free Stopwatch application, the "Battery Free" option on the main menu must be highlighted and the right button (S2) then pushed.

This mode is intended to be used when running from the super cap only. See Section 2.2.6 for more information on how to power the LaunchPad from the super cap.

When the application is entered, a submenu appears showing two possible actions to be taken. The first action is to "Run App," which will start the Battery Free Stopwatch application, and log . The other option is to "Transmit Data," which will transmit all logged data from previous runs through the MSP430 UART to a PC.

The "Run App" selection has four modes:
1. Title Mode (Warning Page)
2. Deep Sleep -LPM3.5 Mode
3. Display Mode
4. Low Battery Indicator Mode

When in Title mode or Display mode, the right button (S2) can be used to put the device into LPM3.5 (Deep Sleep Mode). Also in these two modes, the left button (S1) can be used to exit the app and return to the main menu at any time.

When in Deep Sleep mode, the device remains in LPM3.5, and only the RTC is active. The left button (S1) is deactivated while in this mode, and the right button (S2) can be used to wake the device from LPM3.5 and send the device into Display mode. Also, in this mode the RTC wakes up the device periodically to allow the ADC to sample the supply voltage before returning to LPM3.5. These ADC samples of the supply voltage are logged into FRAM and can be transmitted back to a PC in the "Transmit Data" mode.

The Display mode shows the stopwatch display and also the charge consumed while in LPM3.5. The stopwatch is started when the device enters LPM3.5 and stopped on exit. Hence the total time spent in LPM3.5 is displayed in HH:MM:SS format. The charge indicator is a reflection of the most recent ADC sample of supply voltage. If the device is left inactive at the "Display Mode" screen for more than ten seconds, the app will timeout and control reverts to the main menu.
Low Battery mode is entered conditionally following an ADC measurement of the supply voltage. When \( VCC < 2.2 \text{ V} \), the device will display a "Low Battery" warning screen. The screen will recommend that the device be plugged into the PC through USB for charging. In this mode, the left button (S1) is deactivated, and the right button (S2) is used to check if USB has been plugged in or not. If the device has not been plugged into USB and the right button (S2) is pushed, the device remains in Low Battery mode. If the device has been plugged into USB and the right button (S2) is pushed, the device will enter Deep Sleep mode once again.

When running this application, the ADC measurements are logged in FRAM while the device is running from the super cap indicating that the ADC sampling and FRAM write have a very low power footprint. These logged values can then be sent to the PC and the data processed to analyze the reduction of charge over time. The transfer of data can be done in the UART transmit mode.

The basic operation of the UART transmit mode is outlined below.
1. The eUSCI-UART and DMA modules are set up to transfer the data from FRAM
2. “Sending Data – Please Wait” screen displayed while the operation is in progress
3. On completion “Data Send Complete” screen is displayed
4. The data can be viewed using any hyper terminal application on the PC

### 3.3.6 Active Power Application

The active power of the MSP430FR5969 device is directly dependent on the code and data cache hit ratio and the clock speed of the CPU. The Active Power application shows the impact of both these factors on overall system power.

To measure the power consumption of the MSP430FR5969 for the different frequencies and cache hit ratios, the following steps should be followed:
1. Remove the "Measure Current" jumper from the LaunchPad
2. Use an ammeter set to the "mA" range and connect the leads of the ammeter to the nodes of the "Measure Current" jumper
3. Navigate the main menu to the "Active Mode" app
4. Choose a frequency and cache hit ratio from the subsequent menus
5. Press the right button (S2) to enter the cache hit code
6. Tune the ammeter range to obtain the most accurate current measurement values
7. Prior to exiting the cache hit code, ensure that ammeter is in "mA" range, then press right button (S2) to exit cache hit code

### 3.3.7 SliderBall Game

This application was designed to show the functioning ability of the two Capacitive Touch sliders in conjunction with the LCD from the 430BOOST-SHARP96 BoosterPack.

To enter the application, the SliderBall game option on the main menu must be highlighted and the right button (S2) then pushed. The SliderBall game requires the player to use a sliding paddle to keep the ball in play. The goal of the game is to keep the ball alive and on the screen by having it hit off of the two paddles at each end of the screen. Users start off with five lives to accumulate as many points as possible. For each time that the ball is blocked by the paddle, points are awarded. The higher the difficulty, the more points are awarded for each hit. Each time the ball reaches the end of the screen and the paddle has not hit the ball, the user loses a life. After the life is lost, the ball automatically starts again for another round. This repeats until all lives are exhausted, and the game is over. If the high score has been achieved, a congratulations screen will be displayed to notify the user. At this point the final score, as well as the board high score will be displayed and the user may then choose a new level of difficulty to play once again.
To navigate the user levels menu and choose an option, the left capacitive touch slider and right button are used similarly to all previous menus. The user may choose between the following: easy, normal, hard, and Insane. After selecting a difficulty, the game will begin to start, with the ball moving to the right-hand side first. Both capacitive touch sliders are used to control their respective paddles along the side of the screen. When the user misses the ball, it will be held in place for a few cycles before starting to move again to give the user a chance to regroup following losing a life. To create "easier" versions of the game, sleep cycles are added to slow down the game play.

The high score for each user level is stored in FRAM and is retained on subsequent power cycles. This value is erased only when the device is re-programmed.

3.3.8 Special Notes: Inverting the Display Color Scheme

A feature that has been built into the out-of-box demo code is the ability to invert the display colors. This can be a useful feature for times when the original display color settings are difficult to read.

To invert the colors edit the file 'sharp96x96.h' within the 'grlib' directory. In the 'User Configuration for the LCD Driver' section under 'Invert Display Option' use either one of the # defines 'NORMAL_DISPLAY' or 'INVERT_DISPLAY' as needed.

When INVERT_DISPLAY is defined it allows the out-of-box demo to display with a black background and white foreground once the demo code is re-downloaded onto the MSP-EXP430FR5969 board.

3.3.9 Special Notes: Adding the Out-of-Box Source Files to an Existing Project

These instructions for Code Composer Studio™ IDE also apply to creating a new project for downloading the out-of-box code. Once the source files have been added the following additional project options need to be set.

1. From the Project Properties -> MSP430 Compiler -> Advanced Language Options, Check the 'Enable GCC Support' box
2. From the Project -> Properties -> MSP430 Compiler -> Optimization, set the optimization level to '1'
3. Add all the include paths for the header files present in each subfolder. This is done from Project -> Properties -> MSP430 Compiler -> Include Options. Edit the box titled "Add dir to #include search path" as shown below.

3.4 430BOOST-SHARP96 Graphics Library Demo

NOTE: This graphics library demo is dependent on the 430BOOST-SHARP96 BoosterPack that comes with the MSP-BNDL-FR5969LCD bundle.

The grlib demo shows how to use the MSP430 Graphics Library http://www.ti.com/tool/msp430-grlib or "grlib," in a project with the Sharp® display. This demo cycles screens without user interaction to show simple graphics primitives.

- Pixels
- Lines
- Circles
- Rectangles
- Text
- Images

The demo introduces the functions to configure grlib such as initialization, color inversion, and using foreground and background colors properly.

FRAM memory devices like the MSP430FR5969 are touted for ultra-low power, but in some applications the FRAM memory can provide additional benefits such as dynamic memory allocation. In applications with dot matrix LCD displays, it is often advantageous to keep a RAM buffer of the contents currently on the display. For a smaller display such as the Sharp display on the 430BOOST-SHARP96 BoosterPack, this doesn't require much RAM to keep the display contents.
Additional Resources

\[ \text{RAM bytes required} = \frac{96 \text{ pixels/row}}{8 \text{ pixels/byte}} \times 96 \text{ rows} = 1152 \text{ bytes} \]  

But in displays with more pixels or color displays, these RAM buffers can quickly become very large. If the Sharp display was a color display with 16 bits or color per pixel, (common in color displays) this buffer would be significantly larger.

\[ \text{RAM bytes required} = \frac{96 \text{ pixels/row}}{0.5 \text{ pixels/byte}} \times 96 \text{ rows} = 18432 \text{ bytes} \]

When selecting a microcontroller for an application with a display like this would require a very large memory device for a typical RAM/Flash microcontroller. Typical RAM memory cutoffs would likely require a 32kB RAM device with around 128kB or 256kB of Flash. This may be significantly more memory than the application requires.

FRAM's unified memory block can be dynamically partitioned into data or code memory, providing unmatched flexibility. Applications like this can be easily supported with a 32kB or 64kB FRAM device.

4 **Additional Resources**

4.1 **LaunchPad Websites**

More information about the FR5969 LaunchPad, supported Booster Packs, and available resources can be found at:

- [FR5969 LaunchPad tool page](#): resources specific to this particular LaunchPad
- [TI's LaunchPad portal](#): information about all LaunchPads from TI for all MCUs

4.2 **Information on the MSP430FR5969**

At some point, you will probably want more information about the FR5969 device. For every MSP430 device, the documentation is organized as shown in Table 7.

<table>
<thead>
<tr>
<th>Document</th>
<th>For FR5969</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device-specific data sheet</td>
<td>MSP430FR59xx, MSP430FR58xx Mixed Signal Microcontroller data sheet (<a href="#">SLAS704</a>)</td>
<td>Device-specific information and all parametric information for this device</td>
</tr>
</tbody>
</table>
4.3 Download CCS, IAR, or MSPGCC

Although the files can be viewed with any text editor, 'more can be done with the projects if they're opened with a development environment like Code Composer Studio (CCS), IAR, or Energia.

CCS and IAR are each available in a full version, or a free, code-size-limited version. The full out-of-box demo cannot be built with the free version of CCS or IAR (IAR Kickstart) due to the code size limit. To bypass this limitation, a code-size-limited CCS version is provided, that has most functionality integrated into a library. The code that is built into the library is able to be viewed by the user, but it cannot be edited. For full functionality download the full version of either CCS or IAR.

See the MSP430 software tools page to download them, and for instructions on installation.

4.4 MSP430Ware and TI Resource Explorer

MSP430Ware is a complete collection of libraries and tools. It includes a driver library (driverlib) and the graphics library (grlib) used in the software demo. By default, MSP430Ware is included in a CCS installation. IAR users must download it separately.

MSP430Ware includes the TI Resource Explorer, for easily browsing tools. For example, all the software examples are shown in the tree below.

![TI Resource Explorer](image)

**Figure 16. MSP-EXP430FR5969 Software Examples in TI Resource Explorer**

Inside TI Resource Explorer, these examples and many more can be found, and easily imported into CCS with one click.

4.5 MSP430FR5969 Code Examples

This is a set of very simple code examples that demonstrate how to use the MSP430's entire set of peripherals: ADC12, Timer_A, Timer_B, and so on. These do not use driverlib, rather they access the MSP430 registers directly.
Every MSP430 derivative has a set of these code examples. When writing code that uses a peripheral, they can often serve as a starting point.

There are also code examples available that use driver library. These code examples are part of the driverlib download included with MSP430Ware. To access these code examples, navigate into the driverlib folder or use the TI Resource Explorer to import into CCS.

4.6 MSP430 Application Notes

There are many application notes at www.ti.com/msp430 with practical design examples and topics.

4.7 The Community

4.7.1 TI E2E Community

Search the forums at e2e.ti.com. If you cannot find your answer, post your question to the community!

4.7.2 Community at Large

Many online communities focus on the LaunchPad – for example, http://www.43oh.com. You can find additional tools, resources, and support from these communities.

5 FAQs

Q: I can't get the backchannel UART to connect. What's wrong?

A: Check the following:

- Do the baud rate in the host's terminal application and the USCI_A0 settings match?
- Are the appropriate jumpers in place on the isolation jumper block?
- Probe on RXD and send data from the host; if you don't see data, it might be a problem on the host side.
- Probe on TXD while sending data from the MSP430. If you don't see data, it might be a configuration problem on the USCI_A0 module.
- Consider the use of the hardware flow control lines (especially for higher baud rates)

Q: So the onboard emulator is really open source? And I can build my own onboard emulator?

A: Yes! We encourage you to do so. The design files are on ti.com.

Q: The MSP430 G2 LaunchPad had a socket, allowing me change the target device. Why doesn't this LaunchPad use one?

A: This LaunchPad provides more functionality, and this means using a device with more pins. Sockets for devices with this many pins are too expensive for the LaunchPad's target price.

Q: With the female headers on the bottom, the board doesn't sit flat on the table, and I can't unsolder them. Why did TI do this?

A: For several reasons. A major feedback item on previous LaunchPads was the desire for female headers instead of male ones. But simply using female instead is problematic, because compatibility with existing BoosterPacks would be lost, and some people prefer male headers. So, adding female headers without removing male ones satisfies both preferences. It also allows more flexibility in stacking BoosterPacks and other LaunchPads.

The downside to this approach is perhaps that the board doesn't sit flat. But while a USB cable is attached (the usual development model), it tends to not sit flat anyway.

For those wishing it to sit flat, holes were drilled in the corners, so that standoffs could be fastened. Rubber bumper feet also should work.
Connect Analog and Digital Power Supply

Crystals

LaunchPad Header (left)

LaunchPad Header (right)

Basic User Interface (left)

Basic User Interface (right)

expand functionality with BoosterPacks:
www.ti.com/LaunchPad

Figure 17. Schematic 1 of 5
Main MCU - Debugger and Power Connections

Figure 18. Schematic 2 of 5
eZ-FET - USB Interface and Power Supply

eZ-FET Rev1.2

Figure 19. Schematic 3 of 5
Figure 20. Schematic 4 of 5
eZ-FET - MCU controlled DCDC converter

Figure 21. Schematic 5 of 5
EVALUATION BOARD/KIT/MODULE (EVM) ADDITIONAL TERMS

Texas Instruments (TI) provides the enclosed Evaluation Board/Kit/Module (EVM) under the following conditions:

The user assumes all responsibility and liability for proper and safe handling of the goods. Further, the user indemnifies TI from all claims arising from the handling or use of the goods.

Should this evaluation board/kit not meet the specifications indicated in the User’s Guide, the board/kit may be returned within 30 days from the date of delivery for a full refund. THE FOREGOING LIMITED WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY SELLER TO BUYER AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. EXCEPT TO THE EXTENT OF THE INDEMNITY SET FORTH ABOVE, NEITHER PARTY SHALL BE LIABLE TO THE OTHER FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

Please read the User's Guide and, specifically, the Warnings and Restrictions notice in the User's Guide prior to handling the product. This notice contains important safety information about temperatures and voltages. For additional information on TI's environmental and/or safety programs, please visit www.ti.com/esh or contact TI.

No license is granted under any patent right or other intellectual property right of TI covering or relating to any machine, process, or combination in which such TI products or services might be or are used. TI currently deals with a variety of customers for products, and therefore our arrangement with the user is not exclusive. TI assumes no liability for applications assistance, customer product design, software performance, or infringement of patents or services described herein.

REGULATORY COMPLIANCE INFORMATION

As noted in the EVM User’s Guide and/or EVM itself, this EVM and/or accompanying hardware may or may not be subject to the Federal Communications Commission (FCC) and Industry Canada (IC) rules.

For EVMs not subject to the above rules, this evaluation board/kit/module is intended for use for ENGINEERING DEVELOPMENT, DEMONSTRATION OR EVALUATION PURPOSES ONLY and is not considered by TI to be a finished end product fit for general consumer use. It generates, uses, and can radiate radio frequency energy and has not been tested for compliance with the limits of computing devices pursuant to part 15 of FCC or ICES-003 rules, which are designed to provide reasonable protection against radio frequency interference. Operation of the equipment may cause interference with radio communications, in which case the user at his own expense will be required to take whatever measures may be required to correct this interference.

General Statement for EVMs including a radio

User Power/Frequency Use Obligations: This radio is intended for development/professional use only in legally allocated frequency and power limits. Any use of radio frequencies and/or power availability of this EVM and its development application(s) must comply with local laws governing radio spectrum allocation and power limits for this evaluation module. It is the user’s sole responsibility to only operate this radio in legally acceptable frequency space and within legally mandated power limitations. Any exceptions to this are strictly prohibited and unauthorized by Texas Instruments unless user has obtained appropriate experimental/development licenses from local regulatory authorities, which is responsibility of user including its acceptable authorization.

For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant

Caution

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation. Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

FCC Interference Statement for Class A EVM devices

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.
FCC Interference Statement for Class B EVM devices

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

For EVMs annotated as IC – INDUSTRY CANADA Compliant

This Class A or B digital apparatus complies with Canadian ICES-003. Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

Concerning EVMs including radio transmitters

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Concerning EVMs including detachable antennas

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication.

This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.

Cet appareil numérique de la classe A ou B est conforme à la norme NMB-003 du Canada.
Les changements ou les modifications pas expressément approuvés par la partie responsable de la conformité ont pu vider l’autorité de l’utilisateur pour actionner l’équipement.

Concernant les EVMs avec appareils radio

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de licence. L’exploitation est autorisée aux deux conditions suivantes : (1) l’appareil ne doit pas produire de brouillage, et (2) l’utilisateur de l’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d’en compromettre le fonctionnement.

Concernant les EVMs avec antennes détachables

Conformément à la réglementation d’Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d’un type et d’un gain maximal (ou inférieur) approuvé pour l’émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à l’intention des autres utilisateurs, il faut choisir le type d’antenne et son gain de sorte que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas l’intensité nécessaire à l’établissement d’une communication satisfaisante.

Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d’antenne énumérés dans le manuel d’usage et ayant un gain admissible maximal et l’impédance requise pour chaque type d’antenne. Les types d’antenne non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l’exploitation de l’émetteur.
【Important Notice for Users of EVMs for RF Products in Japan】

This development kit is NOT certified as Confirming to Technical Regulations of Radio Law of Japan

If you use this product in Japan, you are required by Radio Law of Japan to follow the instructions below with respect to this product:

1. Use this product in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for Enforcement of Radio Law of Japan,
2. Use this product only after you obtained the license of Test Radio Station as provided in Radio Law of Japan with respect to this product, or
3. Use of this product only after you obtained the Technical Regulations Conformity Certification as provided in Radio Law of Japan with respect to this product. Also, please do not transfer this product, unless you give the same notice above to the transferee. Please note that if you could not follow the instructions above, you will be subject to penalties of Radio Law of Japan.

Texas Instruments Japan Limited
(address) 24-1, Nishi-Shinjuku 6 chome, Shinjuku-ku, Tokyo, Japan

http://www.tij.co.jp
For Feasibility Evaluation Only, in Laboratory/Development Environments. Unless otherwise indicated, this EVM is not a finished electrical equipment and not intended for consumer use. It is intended solely for use for preliminary feasibility evaluation in laboratory/development environments by technically qualified electronics experts who are familiar with the dangers and application risks associated with handling electrical mechanical components, systems and subsystems. It should not be used as all or part of a finished end product.

Your Sole Responsibility and Risk. You acknowledge, represent and agree that:

1. You have unique knowledge concerning Federal, State and local regulatory requirements (including but not limited to Food and Drug Administration regulations, if applicable) which relate to your products and which relate to your use (and/or that of your employees, affiliates, contractors or designees) of the EVM for evaluation, testing and other purposes.

2. You have full and exclusive responsibility to assure the safety and compliance of your products with all such laws and other applicable regulatory requirements, and also to assure the safety of any activities to be conducted by you and/or your employees, affiliates, contractors or designees, using the EVM. Further, you are responsible to assure that any interfaces (electronic and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely limit accessible leakage currents to minimize the risk of electrical shock hazard.

3. Since the EVM is not a completed product, it may not meet all applicable regulatory and safety compliance standards (such as UL, CSA, VDE, CE, RoHS and WEEE) which may normally be associated with similar items. You assume full responsibility to determine and/or assure compliance with any such standards and related certifications as may be applicable. You will employ reasonable safeguards to ensure that your use of the EVM will not result in any property damage, injury or death, even if the EVM should fail to perform as described or expected.

4. You will take care of proper disposal and recycling of the EVM's electronic components and packing materials.

Certain Instructions. It is important to operate this EVM within TI's recommended specifications and environmental considerations per the user guidelines. Exceeding the specified EVM ratings (including but not limited to input and output voltage, current, power, and environmental ranges) may cause property damage, personal injury or death. If there are questions concerning these ratings please contact a TI field representative prior to connecting interface electronics including input power and intended loads. Any loads applied outside of the specified output range may result in unintended and/or inaccurate operation and/or possible permanent damage to the EVM and/or interface electronics. Please consult the EVM User's Guide prior to connecting any load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative. During normal operation, some circuit components may have case temperatures greater than 60°C as long as the input and output are maintained at a normal ambient operating temperature. These components include but are not limited to linear regulators, switching transistors, pass transistors, and current sense resistors which can be identified using the EVM schematic located in the EVM User's Guide. When placing measurement probes near these devices during normal operation, please be aware that these devices may be very warm to the touch. As with all electronic evaluation tools, only qualified personnel knowledgeable in electronic measurement and diagnostics normally found in development environments should use these EVMs.

Agreement to Defend, Indemnify and Hold Harmless. You agree to defend, indemnify and hold TI, its licensors and their representatives harmless from and against any and all claims, damages, losses, expenses, costs and liabilities (collectively, "Claims") arising out of or in connection with any use of the EVM that is not in accordance with the terms of the agreement. This obligation shall apply whether Claims arise under law of tort or contract or any other legal theory, and even if the EVM fails to perform as described or expected.

Safety-Critical or Life-Critical Applications. If you intend to evaluate the components for possible use in safety critical applications (such as life support) where a failure of the TI product would reasonably be expected to cause severe personal injury or death, such as devices which are classified as FDA Class III or similar classification, then you must specifically notify TI of such intent and enter into a separate Assurance and Indemnity Agreement.
IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All semiconductor products (also referred to herein as “components”) are sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI’s terms and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily performed.

TI assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of significant portions of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional restrictions.

Resale of TI components or services with statements different from or beyond the parameters stated by TI for that component or service voids all express and any implied warranties for the associated TI component or service and is an unfair and deceptive business practice. TI is not responsible or liable for any such statements.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards which anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause harm and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and requirements. Nonetheless, such components are subject to these terms.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties have executed a special agreement specifically governing such use.

Only those TI components which TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components which have not been so designated is solely at the Buyer’s risk, and that Buyer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

Products

Audio
Amplifiers
Data Converters
DLP® Products
DSP
Clocks and Timers
Interface
Logic
Power Mgmt
Microcontrollers
RFID
OMAP Applications Processors
Wireless Connectivity

Applications
Automotive and Transportation
Communications and Telecom
Computers and Peripherals
Consumer Electronics
Energy and Lighting
Industrial
Medical
Security
Space, Avionics and Defense
Video and Imaging

www.ti.com/audio
ampkits.ti.com
dataconverter.ti.com
datahilpi.com
dsp.ti.com
www.ti.com/clocks
interface.ti.com
logic.ti.com
power.ti.com
microcontroller.ti.com
www.ti-rrid.com
www.ti.com/omap

www.ti.com/automotive
www.ti.com/communications
www.ti.com/computers
www.ti.com/consumer-apps
www.ti.com/energy
www.ti.com/industrial
www.ti.com/medical
www.ti.com/security
www.ti.com/space-avionics-defense
www.ti.com/video

www.ti-e2e.com

www.ti.com/wirelessconnectivity

e2e.ti.com